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FOREWORD

The CAMEO Companion is designed to provide a written help resource
for all CAMEO Suite users, particularly those who utilize the software on
an occasional basis. The Companion developers recognize that while
many persons attend CAMEO training courses, the skills gained in those
training sessions fade when persons operate the programs infrequently.
The CAMEO Companion provides explanations and step-by-step
instructions to help CAMEO users perform emergency response and
planning activities learned in CAMEO training classes.

It is an integrated resource, compiling information and assistance for
the four CAMEO components. It is not intended, nor does it claim, to be
comprehensive; the Companion provides refresher-type information for
CAMEO functions commonly used in emergency response and planning
activities. More detailed explanations regarding the CAMEO products
are found in the User Manuals produced by EPA/NOAA which are freely
available on the CAMEO website.

The CAMEO Companion features 2 main sections: CAMEO Companion
for Responders and CAMEO Companion for Planners. The text allows
publication of 1 book containing both sections, or each section may be
published as a stand-alone product. The decision as to how best to
publish the Companion is left to the discretion of those providing this
resource to their constituents.

The developers welcome all comments, criticisms, corrections, and
suggestions related to this work.

Questions or comments related to Companion content may be
addressed to:

Tom Bergman
443 N.W. 46th Terrace, Oklahoma City, OK  73118
405-528-5518, tom.bergman@sbcglobal.net

Questions regarding publication of the materials may be addressed to:

Daniel Roe
Executive Director
Arizona Emergency Response Commission
5636 East McDowell Road, Phoenix, AZ 85008
602-231-6345, Dan.Roe@azdema.gov
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IntroductionIntroductionIntroductionIntroductionIntroduction
THE CAMEOFM SUITE

CAMEOfm is called a “suite” because it encompasses several different
software applications, all which are “connected” through various
methods, and thus “work together” to produce results. Another common
software suite is Microsoft Office, which also consists of several
software applications, all designed to conduct different operations
which work together to produce results.

The CAMEOfm suite is generally considered to include these four
software programs:

1. CAMEOfm

2. ALOHA

3. MARPLOT

4. LandView

Two other applications commonly associated with CAMEOfm are:

1. RMP-COMP - http://www.epa.gov/ceppo/tools/rmp-comp/comp-
dwn.html

2. A.R.C.H.I.E. - http://hazmat.dot.gov/risk_tools.htm

These two programs model chemical releases similarly to ALOHA,
however RMP-COMP and A.R.C.H.I.E. also produce “blast zone” types of
estimates for explosive and/or flammable substances. For more
information, see the associated websites.

STRUCTURE

CAMEOfm: A Relational Database
CAMEOfm is built on the FileMaker Pro platform. FileMaker Pro is a
“relational database”; therefore, you may consider CAMEOfm a
“relational database”. Another common “relational database” is
Microsoft Access.

In simplistic terms, a “relational database” is a collection of
“spreadsheets”, each containing “data” in “fields” or “cells”. Two common
spreadsheet programs are Microsoft Excel and Lotus 1-2-3.
“Spreadsheets” organize data into rows and columns; each intersect of a
row and a column is called a “cell”.
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CAMEOfm consists of a group of several “spreadsheets” that are
“connected” or “linked” so that information contained in one
spreadsheet can be associated with information from a different
spreadsheet. The spreadsheets are thus “related”, hence the name
“relational database”. The importance to CAMEOfm users will be
explained in the following sections.

The CAMEOfm spreadsheets most commonly utilized are called
“modules”, such as, Facilities, Chemicals in Inventory, Contacts, Special
Locations, etc. You may visualize each CAMEOfm module as a
“spreadsheet” with “rows” and “columns” that intersect at a “cell”. Each
“cell” contains data, whether that be a text paragraph (e.g., RIDS
General Description), a number (e.g., Zip Code or IDLH value), a word or
words (e.g., Facility Name), and so forth.

Each CAMEOfm module (or spreadsheet) is “related” to some other
modules. The figure below depicts which modules are related in
CAMEOfm.

ALOHA: THE AIR DISPERSION MODEL

ALOHA is an “air dispersion model”; it is designed to predict downwind
concentrations of various contaminates, vapors, gases, etc. As such,
ALOHA is a “computational” type of software, and does not “integrate”
with software programs in the same manner as other members of the
CAMEOfm suite. However, it is possible to “copy-and-paste” some
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ALOHA outputs, and to “save” screenshots. Also, ALOHA footprints may
be displayed in ArcView using a NOAA ArcMap Import Tool utility.

MARPLOT: A MAP VIEWER

MARPLOT is a “map viewer” software. It interprets data, such as latitude
and longitude, color, line size, line distance, and symbol type, and
displays this data in “map” format. MARPLOT does allow some “data
management” operations, such as Search, Import/Export, Edit, and Save,
but is not considered a “data management” type of software, such as
CAMEOfm and LandView.

MARPLOT does integrate with Microsoft Excel and Word as well as other
mapping applications, such as ArcView and MapInfo.

LANDVIEW

LandView is another “relational database” software, written in FileMaker
Pro as is CAMEOfm. LandView features three main “spreadsheets”:

1. EPA Regulated Sites

2. U.S. Bureau of the Census Data

3. U.S. Geologic Survey, Geographic Names Information System
(GNIS)

These “spreadsheets” contain information provided by these federal
agencies. In addition, LandView features a number of unique internet-
linked functions.

Since LandView is a “relational database”, it can be integrated with other
spreadsheet applications, and may be used to accommodate some data
management functions. However, for the purposes of the manual, most
“data management” type activities are conducted using CAMEOfm.

DEVELOPMENT OF THE CAMEOFM SUITE

CAMEOfm and ALOHA were specifically designed to assist emergency
personnel to plan for and respond to hazardous chemical releases.
LandView and MARPLOT were initially designed to manage geographic
and census data, and became part of the CAMEOfm suite later.

This does NOT mean the CAMEOfm programs are not useful for a wide
variety of user applications. At its core, CAMEOfm is designed for
management of emergency operations related to chemical incidents,
which explains much of “why” the system works as it does.
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The diagram below illustrates some of the ways CAMEOfm suite
programs interface with each other and with external software
programs.
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Using CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft OfficeUsing CAMEOfm With Microsoft Office
ProductsProductsProductsProductsProducts
INTRODUCTION

Because CAMEOfm is basically a collection of linked spreadsheets, it is
possible to move data from CAMEOfm to Microsoft Access and Excel via
importing and exporting functions. It is not recommended that all
users utilize these functions!  However, for those who are already
familiar with Access and/or Excel , these can be used in association with
CAMEOfm to conduct a number of useful applications.

Also, you are not limited to using only Microsoft Office applications. For
example, Lotus 1-2-3 can be used to do the same functions as Microsoft
Excel. This manual is not intended to promote Microsoft Office
products in any manner. The examples in this manual use Microsoft
Excel and Microsoft Word simply because they are more commonly used
than other spreadsheet and word processing programs.

EXPORTING CAMEOFM TO MICROSOFT EXCEL PROCESS

Exporting from CAMEOfm

1. Activate CAMEOfm

2. Select the "File" menu

3. Select “Import/Export”

4. Select “Export”

5. Select “Export All CAMEO Data”
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Example CAMEOfm Save Screen

6. Select a “location” using the “Save In:” box

7. Name the file

8. Select the “Save” button

At the specified “Save” location, there will now be a .zip file with the
user-specified “name”.

9. Minimize your CAMEOfm screen

10. Browse the “Save” location

11. Double-click on the saved .zip file

Your screen should look similar (if not exactly) like the example CAMEO
Export Opened .zip File Screen illustrated on the next page.
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Example CAMEO Export Opened .zip File Screen

These 14 files contain ALL the information from your CAMEOfm
program, except the Chemical Library module (which is not exportable).

Unzipping the File*
Depending on your computer
operating system and the particular
zip software, there are several
methods of unzipping this file. You
must unzip the CAMEOfm-exported .zip file and save somewhere on
your computer; recommend you save to a specific folder, perhaps
named “CAMEOfm Exports”.

After the .zip file is unzipped, any or all of these files may be “opened”
using Microsoft Excel, Lotus 1-2-3, etc. Again, there are several methods
of opening the individual files.

CAMEOfm exports in “mer” files (merge files) format. Merge files are
“comma separated value” (.csv) files. Microsoft Excel and other
spreadsheet programs recognize .csv  files.

Note:  Your computer must have
a “zip” program to proceed.
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Here is one method which will open the .mer files in Microsoft Excel:

1. Right-click on any of the unzipped .mer files

2. Select “Rename”

3. Change the file extension from “.mer” to “.csv”

Usually, you will see this message box:

Example Excel Rename Message Box

4. Select “Yes” and proceed

Notice the “file icon” is now an Microsoft Excel file. Double-click on the
new .csv file icon, and it will activate and open in Microsoft Excel.

You now have the correct “format” for importing data to a single
CAMEOfm module using Microsoft Excel. The importing process is
discussed in a later section of this manual.

EXPORTING MARPLOT TO MICROSOFT EXCEL PROCESS

MARPLOT exports in three different formats:

1. MARPLOT Import/Export files (.mie)

2. Simple Point Export (.txt)

3. GENERATE files (for use with ArcInfo software)

A Simple Point Export (.txt) can be opened in Microsoft Excel. A “simple
point” object in MARPLOT is defined as a single intersection of a
Latitude and a Longitude. Thus, many map objects are not generally
expressed as a “simple point” )i.e. Roads, Lakes, City Limits, Zip Code
Areas, Canals, and Railroads).
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However, many MARPLOT objects can be expressed as a “simple point”.
Any MARPLOT object shown as a “symbol” is a simple point object.
Common examples are Facilities, Day Care Sites, Storm Shelters, Fire
Stations, EMS Locations, Hospitals, etc.

MARPLOT allows import/export of simple point object sets using any
spreadsheet-type program, such as Microsoft Excel or Lotus 1-2-3. This
can be an extremely useful tool to enter new locations to MARPLOT.

1. Activate MARPLOT

2. Select any simple point object (usually displayed as a “symbol”)

3. Select the “File/Export” menu

4. Select “MARPLOT Simple Point Format”

Example MARPLOT Export Box

5. Select “Export” button

6. Name and save the file (make sure it saves as a .txt file)
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Example MARPLOT Export Screen

This .txt file can be opened using Microsoft Excel.

1. Activate Microsoft Excel

2. Select the “File/Open” menu

3. Set the “File Type” to “Text” Files
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Example Microsoft Excel “Open File” Box

4. Double-click on the saved export .txt file; your screen will
resemble the example below.

Example Microsoft Excel Open Delimited Data Box
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5. Select “Next”

6. Select “Finish”; your screen will look like the example below.

Example MARPLOT Simple Point Export .txt File Opened in Microsoft
Excel
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Notice there are no “column headers”. The column labels would be:

Example MARPLOT Simple Point Export .txt File Opened in Microsoft
Excel with Column Headings Added

You now have the correct “format” for importing “simple point” files to
MARPLOT. The importing process is discussed in a later section of this
manual.

“COPY-AND-PASTE” FROM CAMEOFM SUITE PROGRAMS TO WORD

PROCESSORS

Standard “copy-and-paste” commands function for all the CAMEOfm
suite programs. In CAMEOfm, the familiar “right-click” mouse
functions are not enabled; use the “Edit” menu for copy-and-paste
commands.
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Entering Information to the CAMEOfmEntering Information to the CAMEOfmEntering Information to the CAMEOfmEntering Information to the CAMEOfmEntering Information to the CAMEOfm
SuiteSuiteSuiteSuiteSuite
ENTERING PAPER TIER 2 REPORTS TO TIER 2 SUBMIT

It is quicker and easier to enter “paper” Tier 2 reports to Tier 2 Submit,
then export the record(s) and import to CAMEOfm.*

1. Activate Tier 2 Submit

2. Select the “Start Tier 2 Submit” button

3. Select the “New Facility” hot button

4. Enter information from the form to
the “Address” page

5. Select the “Location and ID” tab;
continue until finished

6. Select the “Contacts” tab

7. Select “Add Contact”

Tier 2 Submit will display a list of all contacts available. To prevent
duplication, you will want to determine if the contact is already in the
list. One method is to simply use the scroll bar to examine the contact
list.*

8. Continue through the State Fields, Certification, and Notes tabs

9. Select the “Chemical Inventory” hot button; continue entering
information to appropriate fields and tabs.

10. Select the “New Chemical in Inventory” hot button and continue,
if more than one chemical needs to be entered

Note: Tier 2 Submit is
always in “Edit” mode,
and entered data is
always “Saved” without
any actions.

Note:  When there are hundreds or thousands of contact entries to
examine, you should use the FileMaker “Find” function (see Data Entry Tips
Section below).
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Entering Multiple Facilities
See Data Entry Tips/Duplicate Record Function for Entering Multiple
Facilities below.

DATA ENTRY TIPS

FileMaker Find Function
After selecting the “Add Contact” button, the “Pick a Contact” screen
appears and the “Search” menu is disabled. You may use the FileMaker
“Find” function as a search engine at this point.

1. Select the “Browse” button located in the lower left side of the
screen

2. Select “Find” from the pop-up menu; the “Pick a Contact” fields
will appear empty.

3. Enter the desired Contact Name to the appropriate field

4. Hit the “Enter” key on your keyboard

Either a list of contacts with the “search” name or the “No records match
this request” text will appear.

Validate Record Function
After completing data entry for a record, you should ALWAYS check your
work using the “Validate Record” function.

1. Activate the Facilities List screen

2. Select the record you wish to “validate”

3. Select the “Record” menu

4. Select “Validate Record”

Tier 2 Submit examines the record to determine all required fields have
“data”. The validation function CANNOT determine if the data is
“accurate”, but CAN determine if a required field is “blank” or has
incorrectly formatted data.
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If a data field needs to be “fixed”, the following message box will
appear.

Example Tier 2 Submit Failed Validation Prompt

In some cases, you will choose to “Ignore” the “validation error” and
continue. Otherwise, select the “Go To Field” button and the cursor will
be transported to the exact field Tier 2 Submit has determined is in
error.

Duplicate Record Function for Entering Multiple Facilities
Tier 2 Submit features a “special” Duplicate Record function that is
useful when entering multiple facilities from one company. In many
cases, the contacts and chemical information is identical for all
submitted Tier 2 records, and you can accelerate data entry by
“copying” a record and altering only the Facility Name and Address.

1. Set your screen to the Facilities list

2. Highlight the “Facility” you wish to copy

3. Select the “Record” menu

4. Select “Duplicate Record”

The entire record has been copied, including all the Chemical Inventory
and Contact information; change ONLY the information that is different
from the preceding record.
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ENTERING PAPER TIER 2 REPORTS DIRECTLY TO CAMEOFM

Entering Tier 2 paper forms for CAMEOfm is much the same as entering
to Tier 2 Submit, but is usually a more lengthy process due to the
following differences:

1. The “Duplicate Record” function is NOT active in CAMEOfm

2. The “Validate Record” function is NOT active in CAMEOfm

3. The screen layout in CAMEOfm does not mirror the paper forms
as well as Tier 2 Submit does.

MOVING RECORDS FROM TIER 2 SUBMIT TO CAMEOFM

Tier 2 Submit “File” menu offers two “export” functions: “Export” and
“Create Submission”.

EXPORTING FROM TIER 2 SUBMIT FUNCTION

1. Activate Tier 2 Submit

2. Select the "File" menu

3. Select “Import/Export”

4. Select the appropriate “Records to include in Export” option

5. Select “Export Files”

6. Name and save the export file

Create Submission Function

1.  Activate Tier 2 Submit

2. Select the "File" menu

3. Select “Create Submission”

4. Select the appropriate “records to include for submission”
option

5. Select “Start Submission Validation” button

Tier 2 Submit examines the record(s) selected for submission to
determine all required fields have “data”. The validation function
CANNOT determine if the data is “accurate”, but CAN determine if a
required field is “blank”, or has incorrectly formatted data. When
validation finds a “blank” field, the following screen appears.
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Example Tier 2 Submit Failed Validation Report Box

You may select the “View Validation Report” to see what data fields need
to be altered.

After viewing the validation report screen, you may use the “File/Close“
menu to return to the Facility list.

When the selected records “pass” the validation process, you may
proceed to either print a “paper report” or create an export file to
import into CAMEOfm.

6. Select “Create Electronic File”

7. Name and Save the file
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Transferring Data from Tier 2 Submit to CAMEOfm
Tier 2 Submit exports data in a .zip file which can be imported directly
to CAMEOfm. After completing a Tier 2 Submit “export”, perform the
following steps:

1. Activate CAMEOfm

2. Select the "File" menu

3. Select “Import/Export”

4. Select “Import”

5. Select “Import” from the “backup your data” message box

6. Browse to the saved Tier 2 Submit .zip file and double-click

Transferring Data from Tier 2 Submit to Microsoft Access
EPA has a “utility” which transfers records from Tier 2 Submit to
Microsoft Access, and from Microsoft Access to Tier 2 Submit. This is a
free utility, and can be obtained (along with instructions on how to
operate the utility) by request to EPA Headquarters or any of a number
of state EPCRA contacts.

Transferring Data from Tier 2 Submit to Microsoft Excel
Any Tier 2 Submit record(s) which includes lat/long values can be
transferred to MARPLOT using a spreadsheet software (see the
Importing Microsoft Excel to MARPLOT section).

Adding/Entering CAMEOfm Special Locations/Routes/
Resources to CAMEOfm
There is no “customized” software to enter records to the remaining
CAMEOfm modules. Data entry is achieved by either “direct” or “manual”
entry, or by utilizing a “spreadsheet import” method (see Importing
from Spreadsheets to CAMEOfm section).*

Note: The critical decision in CAMEOfm data
entry is determining which module should house
the desired record. Before entering ANY data, you
should review the CAMEOfm modules to determine
which offers the most appropriate data fields for
the record information.
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Linking CAMEOfm Special Locations/Routes/Resources to
MARPLOT
You may “enter and link” CAMEOfm records to MARPLOT objects
simultaneously. After entering a CAMEOfm record:

1. Activate MARPLOT

2. Locate the record site in MARPLOT

3. Open or create the appropriate MARPLOT layer (“List” menu)

4. Use the cursor to click on the record site

5. Set the “Object Settings” as desired (do not enter an object
name)

6. Make sure the object in “selected” (surrounded by four red
squares)

7. Select the “Sharing/CAMEOfm/Link Object” menu

8. Make sure the appropriate CAMEOfm record is active or
highlighted

9. Select the “Link” menu (in CAMEOfm)

10. Select “Link this record”

To determine if the link process was successful:

1. Make sure the CAMEOfm record is active

2. Select the “Sharing/MARPLOT/Show This Record” menu

If the link is active, the MARPLOT screen will be resized to window width
of 0.60 miles with the object centered.

USING “COPY-AND-PASTE” TO ENTER DATA TO CAMEOFM

MODULES

You may “copy-and-paste” to CAMEOfm data fields. However, the “right-
click” function is not active in CAMEOfm; use the "Edit" menu for “copy-
and-paste” commands.

Entering Site Plans and Other “Image” Files to CAMEOfm
CAMEOfm has a folder named SITE PLANS specifically designed to store
image files: .jpg, .gif, .tif, and .bmp. Typically, this is used to house
facility site plans, maps, diagrams, digital photos, and aerial photos.

CAMEOfm Site Plans is a viewer file only; editing of the images must be
done outside the confines of CAMEOfm and then saved to the Site Plans
folder.
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Basic steps for attaching site plans are as follows:

1. Save the image in one of the acceptable formats

2. Save OR copy the image to the Site Plans folder in CAMEOfm;
remember the file name and extension, you will need that
information to type into a text box later

3. Open the facility record you wish to link with the image

4. Select the “Site Plans” tab

5. Choose “Edit” from the module toolbar

6.  Follow the instructions on the screen*

Editing CAMEOfm Site Plans
Almost all computers feature some type of “photo editor” software
which may be used to alter or add information to CAMEOfm image files.

1. Use the Explore function to open the CAMEOfm Site Plans folder

2. Double-click on the desired image file

Usually, this will open the selected image file in whatever photo
software is present on your computer. You may then alter the photo as
desired, and “save” back to the CAMEOfm Site Plans folder. The changes
will now display in CAMEOfm.

INSERTING IMAGE FILES INTO MARPLOT
MARPLOT will display .bmp format image files. To place any .bmp file in
MARPLOT:

1. Activate MARPLOT

2. Open layer (or create the desired layer) (“List” menu)

3. Select the "Edit" menu

4. Select “Insert Picture Object”

5. Select “Use Existing Map”

Note:  The EXACT image file name and extension
MUST be entered. You may “copy-and-paste” the
filename with extension from the Site Plans folder
into the CAMEOfm edit screen using the "Edit"
menu commands.
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6. Select “File”

7. Browse to the image file location and double-click

8. Set Object Settings as desired (suggest setting to “User’s Map”)

9. Use  the “Geo-Reference” function (discussed in a later section)
if desired

10. Select "OK"

The image file should now be displayed on the MARPLOT screen.

Moving the Inserted Picture to the Bottom of the Layer List
MARPLOT treats “picture files” as one solid object, thus the inserted
picture may obscure other layer data. It is usually best to use the Layer
List to “move” the layer containing the inserted image to the “bottom”
of the Layer display list.

1. Open the MARPLOT “List/Layer List”

2. Highlight the layer containing the inserted picture object

3. Select “Draw Order” at the top left of the “Layer List” box

4. Select the “Move” button

5. Select “Bottom”

6. Select "OK"

ADDING NEW LOCATIONS TO MARPLOT
Adding a Single Location

1. Activate MARPLOT

2. Select “List/Layer List” menu

3. Open or create the appropriate layer

4. Select "OK"

5. Use the draw tools to create the object

6. Set Object Settings to either “User’s Map” or “CAMEO Map”

7. Select "OK"
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Importing Multiple “Simple Point” Locations using Microsoft
Excel*

1. Create an Microsoft Excel file as shown below.

Example MARPLOT Simple Point Export .txt file Opened in Microsoft
Excel with Headers Added

2. Enter data to the appropriate Microsoft Excel columns;
remember to use “negative” values for Longitude.

The MARPLOT Layer Name column can contain multiple layer names. It
is NOT necessary to repeat this process for multiple MARPLOT layer
entries; it can be performed with one Microsoft Excel file. What layer
name is entered in MARPLOT will be “created” or “used” when imported.

3. Make sure the MARPLOT Map name is either “User’s Map” or
“CAMEO Map”.

Symbol name and color are not critical; those can be changed after
importing.

Note:  Review Exporting MARPLOT to Microsoft Excel section before proceeding.

○ ○ ○

○

○
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The MARPLOT ID Number is the “critical field”.  The ID numbers
MUST BE UNIQUE!

A discussion of MARPLOT ID numbers is found on page 22 of the
MARPLOT Technical Documentation book available at http://
response.restoration.noaa.gov/cameo/pdf/MARPLOTTechDoc.pdf.

Here is one idea for creating MARPLOT ID numbers:

1. Activate EXCEL

Begin the ID number with the characters “BD”, followed by the “Layer
Name”, followed by zeros  and ending with the number  “1” to make a
20-character entry. Example: BD_CityHydrants00001

This is a 20-character ID that is unlikely to be “duplicated” by a random
MARPLOT ID assignment.  The remaining ID numbers can be created
using the Microsoft Excel Edit/Fill/Series/Autofill function.

2. Highlight Column H from cell 1 to last data row.

Example Excel Screen Ready to Autofill MARPLOT ID Numbers

3. Select the “Edit/Fill/Series” menu

4. Set to “Autofill”
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Example Excel Autofill Function Screen

5. Select OK

Example Excel Screen with MARPLOT IDs using Autofill
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Each ID number is now “unique”. When finished entering data, delete the
1st row of header names; MARPLOT will not import files with the header
names.

6. Save as a .txt file.

7. Close Excel*

IMPORTING .TXT FILES TO MARPLOT
1. Activate MARPLOT

2. Select the “File/Import” menu

3. Set File Type to “.txt”

4. Browse to the desired .txt file

5. Select the “Open” button

Example Import .txt File to MARPLOT Screen

The new locations should now display in MARPLOT.

Note: Make sure to delete the “Headers” row
before attempting to import the .txt file to
MARPLOT. MARPLOT will recognize ONLY
rows that begin with a longitude value.
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Converting ArcView Shapefiles to MARPLOT

The Shp2mie.exe Utility
A utility to “convert” ArcView .shp files to MARPLOT .mie files is found in
the LandView 5 folder.

1. Right-click on the “Start” button

2. Select “Explore”

3. Click on the “lv5” folder (usually found on your c: drive)

4. Scroll down on the right side of the explore window;  (the
shp2mie.exe icon is blue and red balls inside a yellow square)

To operate the shp2mie.exe, you will need to have a .shp file and its
associated .dbf file in a folder on your computer. Further steps to
convert the .shp file may require some knowledge of the ArcView
software.

Example Shp2mie.exe Shown from Explore Screen
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IMPORTING ARCVIEW “SIMPLE POINT” OBJECTS INTO MARPLOT
USING MICROSOFT EXCEL

For “simple point” objects, it is possible to output ArcView points as an
Microsoft Excel file containing Lat/Long and Object Name. You can
import the information to MARPLOT using the “Importing multiple
simple point locations using Microsoft Excel” process explained in the
preceding section.

You may then import the additional information contained in the .shp
file to CAMEOfm using the spreadsheet methods explained in previous
sections.

IMPORTING LAT/LONG SPREADSHEETS INTO LANDVIEW USING

MICROSOFT EXCEL

It is possible to import lat/long spreadsheets directly to LandView. For
some types of data sets, this could be a preferred option.

1.  Activate LandView

2. Select the “System” menu

3. Select “User Files”

Instructions on importing to the LandView User Files can be obtained by
selecting the “Help” button.

ADDING INFORMATION TO ALOHA
Adding Locations to ALOHA

1. Activate ALOHA

2. Select "Site Data" menu

3. Select “Location”

4. Select “Add”

5. Enter Name, Elevation, Lat/Long, and State

6. Select “"OK"”

Adding New Chemicals to ALOHA
The ALOHA Chemical List features mainly “pure” chemicals, along with
five “solution” substances. You are free to add more chemicals to the
list, provided sufficient chemical  property information can be obtained.
In many cases, facilities can provide the chemical properties data
necessary to enter additional “mixture” and/or “solution” substances.
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To add a chemical to ALOHA:

1. Obtain Chemical Property Data

2. Activate ALOHA

3. Select “Setup” menu

4. Select “Chemical”

5. Select “Add”

6. Enter data to appropriate fields

MODIFYING/EDITING CHEMICAL PROPERTIES IN ALOHA
You may “modify” or “alter” the ALOHA Chemical List. While it is NOT
recommended to alter the chemical property data in ALOHA, you may
wish to set the Default LOC values. For example, LOC values for several
chemicals is set to AEGL as default, you may use the Modify function to
set those to ERPG, IDLH, or other user-selected LOC values.
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ALTERING/EDITING DATA

Editing CAMEOfm Records

A Single Record

1. Open the desired CAMEOfm module

2. Find and select the desired record

3. Select the “Edit” hot button*

FileMaker “Find” Function for CAMEOfm: Another “Search” option
CAMEOfm features two types of search functions. The “Search” menu
with the Basic Search and Advanced Search answers most user search
needs.

However, when CAMEOfm is in “Edit” mode, the “Search” menu is
disabled. In those cases, the FileMaker “Find” function is valuable.

The FileMaker “Find” function is found in the lower left corner of your
screen. Typically, the function button is set to “Browse”. When “selected”
(using your mouse) a drop-down list arrow is displayed.

To use the FileMaker “Find”:

1. Use your mouse to click on the “Browse” button. A drop-down
list will appear listing the following: “Browse”, “Find”, and
“Preview”

2. Set the button to “Find”. A screen with blank fields will appear.

3. Enter your search criteria to the appropriate box and hit the
“Enter” key from you keyboard.

FileMaker will conduct a search based on your input criteria and return
a “Found Set”. This same “Find” function works for Tier 2 Submit as well.

*Note:  You may alter “related” records from the associated module; i.e. selecting
a record from the Facilities module allows editing of the related Contacts, Chemicals
in Inventory, Phones, Map Data, etc.
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Multiple Records using Microsoft Excel
A previous section of this book discussed a method for exporting
CAMEOfm data and “opening” it in Microsoft Excel. This can be a useful
tool for multiple record edits. Here is an example of using this method
to edit a dataset:

Example: Suppose there are a number of “propane” records in your
Chemicals In Inventory module that were incorrectly assigned as “EHS”
substances. Of course, you could use the “single record” method to
correct each “propane” record individually. As an alternative, you might:

1. Conduct a search in the Facilities module for all “propane”
records

2. Use the “File/Export” menu to export the Found Set

3. Unzip the exported file

4. Change the “ChemicalsInInventory.mer” file to
“ChemicalsInInventory .csv”

5. Open the .csv file using Microsoft Excel

The Microsoft Excel file should contain ONLY records including the word
“propane” in the name. Of course, there may be some entries that
include the word “propane” as part of their chemical name.

Notice in the example screenshot that some of the CiEHSChemical
column entries are “T” (for True) while others are “F” (for False)
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Example ChemicalsInInventory.csv File Opened in Microsoft Excel

6. Locate the “CiEHSChemical” column in Microsoft Excel

7. Use Microsoft Excel functions to change all “CiEHSChemical”
column entries to “F”
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Example ChemicalsInInventory.csv File Opened in Microsoft Excel
with Alterations

8. Save the altered Microsoft Excel file as
“ChemicalsInInventory.csv”

9. Close Microsoft Excel

Now, you can import the altered file back to CAMEOfm and your
changes will be active.

10. Rename “ChemicalsInInventory.csv” to
“ChemicalsInInventory.mer”

11. Insert the new “ChemicalsInInventory.mer” back into the original
exported CAMEOfm .zip file.

12. Use the “File/Import” menu to import the .zip file containing the
altered “ChemicalsInInventory.mer” back to CAMEOfm
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Note:  Be careful! If these MARPLOT objects are “linked” to CAMEOfm records,
changing the object layer or map will remove the CAMEOfm link. These MARPLOT
objects will then have to be “re-linked” to the corresponding CAMEOfm records.

ASSIGNING MARPLOT OBJECTS TO DIFFERENT LAYERS AND MAPS

A Single Object
1. Activate MARPLOT

2. Unlock both the layer containing the object and the layer to
which you wish to “move” the object

3. Select the desired object

4. Select the “Objects/Object Settings” menu

5. Set the layer and map as desired*

Multiple Objects
The same process can be used to “move” multiple objects to different
layers and maps. Objects to be moved may be “selected” using the
“Shift-click” function, or by using a “Search/Show All on Map” function.

Multiple Objects using Microsoft Excel
A previous section of this book discussed a method for exporting
MARPLOT simple point objects and “opening” them in Microsoft Excel.
This can be a useful tool for multiple record edits.

1. Export the desired objects to a .txt file

2. Open the .txt file in Microsoft Excel

3. Use Microsoft Excel functions to set desired layer and map
names

4. Save the file and import back to MARPLOT*

Renaming MARPLOT Objects
Renaming MARPLOT objects uses the same processes as assigning to
different layers and/or maps.

Note: If the layer and map settings are “grayed out”, it means the layer
containing this object is “locked”. You will need to “unlock” the layer before editing
the specific object.

You may change the layer and map setting directly from the “Objects” menu.

○ ○ ○ ○ ○ ○ ○ ○ ○
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Linking DataLinking DataLinking DataLinking DataLinking Data

LINKING MARPLOT OBJECTS TO CAMEOFM RECORDS

A Single Object to Record: Sharing Menu

1. Activate MARPLOT

2. Select the object to be linked

3. Select the “Sharing” menu

4. Select “CAMEOfm” and “Link Object”; this will activate CAMEOfm

5. Open or select the appropriate CAMEOfm record

6. Select the “Link” menu

7. Select “Link this record”

To determine if the link was successful:

8. Select the “Sharing” menu in CAMEOfm

9. Select “MARPLOT” and “Show on Map”

If the link is operational, the screen should activate MARPLOT, and
display the linked object centered with a scale of 0.08 window width.
Depending on your layer settings, the object should now display a name
taken from the CAMEOfm record.

Multiple Objects and Records: MapData.CAM file

Viewing the MapData.CAM file in CAMEOfm

1. Activate CAMEOfm

2. Open the “Window” menu

3. Select “MapData.CAM”
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Example CAMEOfm MapData.CAM Window screen*

4. Select “View Data”

Note: If MapData.CAM is not present under the Window list, it is not “open”. To
open, select any linked CAMEOfm record and do a Sharing/Show on Map
command.
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Example CAMEOfm MapData.CAM View Data Screen

This is the file that links CAMEOfm records to MARPLOT objects. Notice
it is a spreadsheet containing CAMEOfm IDs, MARPLOT IDs, and the
MARPLOT layer and map names.

The MapData.CAM window can be closed by either of the following
steps:

M Select “File/Close”

M Select “Window/Navigator”

Opening MapData.CAM using Microsoft Excel

1. Export a single or group of CAMEOfm Facilities, Special
Locations, or Resources

2. Unzip the resulting .zip export file; a “MapData.mer” file should
be found along with the other unzipped files

3. Change “MapData.mer” to “MapData.csv”

4. Open in Microsoft Excel
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Example MapData.csv File Opened in Microsoft Excel

The 1st column, “RecordKey”, is a CAMEOfm ID to link the CAMEOfm and
MARPLOT ID numbers. You will “create” the RecordKey number,
formatted as beginning with “MD” and containing 18 other characters.

The 2nd column, “ParentRecordID”, is the CAMEOfm ID number taken
from any of the CAMEOfm modules that can be linked to MARPLOT (i.e.,
Facilities, Special Locations, Routes, Resources, and Incidents). These
IDs can be “copy-and-pasted” from the associated CAMEOfm exported
.mer files.

The 3rd, 4th, and 5th columns are for MARPLOT layer, map, and ID data.
These can be “copy-and-pasted” from a MARPLOT Simple Point Export
.txt file.

5. Use the “cut-and-paste” and other Microsoft Excel functions to
insert data to be linked.

6. Save the file as “MapData.csv”

7. Close Microsoft Excel

8. Change the file name to “MapData.mer”
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9. Zip the file, or copy back to original exported CAMEOfm export
.zip file

10. Import .zip file back to CAMEOfm

LINKING CAMEOFM SITE PLANS TO CAMEOFM RECORDS

First, the desired Site Plan(s) must be present in the CAMEOfm Site Plans
folder. You may “paste” to the Site Plans folder using “Explore”
functions.

1. Right-click on the “Start” button from your bottom taskbar

2. Select “Explore”

3. Find the CAMEOfm folder in the left side of your Explore screen

4. Select the “+” sign next to the CAMEOfm folder to “expand” the
folder

5. The Site Plans folder should be visible

6. Paste desired Site Plan(s) into the folder

Example CAMEOfm Site Plans Folder Opened in Explore
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A Single Site Plan: Edit Function

1. Activate CAMEOfm

2. Select the record to be linked to a site plan

3. Select the “Site Plans folder” tab

4. Select the "Edit" hot button

5. Follow the instructions; remember to include the filename
extension

6. Continue to “add” site plan names for the selected record until
finished

7. Select “Save Changes”

Example CAMEOfm Edit Site Plan Screen
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Multiple Site Plans: SiteDataLink.CAM File

Viewing the SitePlanLink.CAM file in CAMEOfm

1. Activate CAMEOfm

2. Open the “Window” menu

3. Select “SitePlanLink.CAM”

Example CAMEOfm SitePlanLink.CAM File

This is the file that links CAMEOfm Records to Site Plans. Notice it is a
spreadsheet containing only CAMEOfm IDs and site plan names.

 The SitePlanLink.CAM window can be closed by either of the following
steps:

M Select “File/Close”

M Select “Window/Navigator”
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OPENING SITEPLANLINK.CAM USING MICROSOFT EXCEL

1. Export a single or group of CAMEOfm Facilities or Special
Locations

2. Unzip the resulting .zip export file

3. A SitePlanLink.mer file should be found along with the other
unzipped files

4. Change “SitePlanLink.mer” to “SitePlanLink.csv”

5. Open in Microsoft Excel

Example CAMEOfm SitePlanLink.CAM file Opened in Microsoft Excel
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6. Use “cut-and-paste” and other Microsoft Excel functions to insert
data to be linked.

7. Create correctly formatted “RecordKey” ID numbers for each row

8. Save the file as “SitePlanLink.csv”

9. Close Microsoft Excel

10. Change the file name to “SitePlanLink.mer”

11. Zip the file, or copy back to original exported CAMEOfm export
.zip file

12. Import .zip file back to CAMEOfm
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Getting Data OutGetting Data OutGetting Data OutGetting Data OutGetting Data Out

MAKING REPORTS IN CAMEOFM

CAMEOfm Make Report Function

1. Activate CAMEOfm

2. Open the appropriate CAMEOfm module

3. Select the desired record(s)

4. Select the “File/Make Report” menu

5. Select data to include in report

Copy-and-Paste to Microsoft Word

1. Perform Steps 1 – 5 from above

2. Highlight text you wish to paste into Microsoft Word

3. Select the "Edit" menu

4. Select “Copy”

5. Paste into Microsoft Word

CAMEOfm Reports using Microsoft Excel

1. Activate CAMEOfm

2. Open the appropriate CAMEOfm module

3. Select the desired record(s)

4. Select the “File/Import/Export” menu

5. Export data to .zip file

6. Minimize or close CAMEOfm

7. Unzip the .zip export file

8. Select the .mer file(s) containing desired report information

9. Change “.mer” file extension(s) to “.csv”

10. Open in Microsoft Excel and create the report
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Example: Creating an “Owner” Mailing List

1. Activate CAMEOfm

2. Select the “File/Import/Export” menu

3. “Export All CAMEO Data”

4. Unzip the exported file to a folder

5. Change the “Contacts.mer” file to “Contacts.csv”

6. Open “Contacts.csv” in Microsoft Excel

7. Delete all contacts that are not “owners”

8. Delete all Microsoft Excel Columns except those containing
name and address data

9. Use Microsoft Word “Mail Merge” function to create and print
the list of names and addresses; these could be printed to
labels or to envelopes, depending on your printer settings

SAVING MARPLOT SCREENS AS A BITMAP

1. Select the "File" menu

2. Select “Save as picture”
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Example MARPLOT Save as a Picture screen

The MARPLOT screenshot is now an “image” file. The .bmp file may be
converted to .jpg or .gif using any photo editing software (i.e., Paint,
PhotoShop, etc.).

Copy-and-Paste into other Software Programs
There are several ways to save MARPLOT screenshots to other software
applications. Here are two methods:

Method 1

1. Save the screenshot as a .bmp file following above instruction

2. Insert or paste the .bmp file to the desired software
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Method 2

1. Activate MARPLOT

2. Set the screen layers and scale as you wish to have it “saved”

3. Select “ALT-Print Screen” from your computer keyboard

4. Activate the software where you wish to paste the picture

5. Select “CTRL-V” from your computer keyboard

There are other methods to move the MARPLOT screen to another
software. Some of the same processes will also move ALOHA and
CAMEOfm screens to other programs.

Saving MARPLOT Screenshots to CAMEOfm Site Plans
1. Save the MARPLOT screen as a .bmp file to the CAMEOfm Site

Plans folder

2. You may now “link” the MARPLOT .bmp file to a CAMEOfm
Facility or Special Location Record (see Linking CAMEOfm Site
Plans to CAMEOfm Records)

SAVING ALOHA INFORMATION

Displaying Multiple ALOHA Plumes on MARPLOT Maps
Although ALOHA 5.3 can produce three footprints simultaneously, those
footprints differ ONLY by Level of Concern values. You may have need
to display multiple ALOHA footprints for differing Wind Direction, Wind
Speed, Source Options, Amount Released, etc.

To display such differing ALOHA footprints, you may use the MARPLOT
Layer and Draw Tool functions to “trace” the footprints, thus creating
new MARPLOT objects. Once the object is created, you may “save” or
“print” the MARPLOT screens as discussed in above sections.*

Note: Recommend use of the “Polygon” tool to “draw” the ALOHA various
footprints on MARPLOT.
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Saving ALOHA as .alo Files
The ALOHA “File/Save” or “Save As” menu allows you to save the current
ALOHA information as a .alo file. .alo files can be opened back to
ALOHA in two formats: Response Mode or Planning Mode. Use the
ALOHA “Help” menu to determine which mode is best for the situation.

Copy-and-Paste into other Software Programs
The five ALOHA output screens can be transferred to word-type
programs using “copy-and-paste” functions.

Copying to Microsoft Word

1. Activate ALOHA

2. Activate the output screen to be copied (Footprint,
Concentration, Dose, or Source Strength)

3. Select the “Edit/Copy” menu

4. Paste into Microsoft Word

The Text Summary information may also be pasted in Microsoft Word,
but the process is slightly different. Use you mouse to “highlight” the
text you wish to copy, then use the "Edit" menu or right-click to “copy-
and-paste” the selected text.

Another “copy-and-paste” option is to use the “Alt/Print Screen” and
“CTRL-V” keyboard functions. You can transfer all five ALOHA output
screens simultaneously using this method.
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Sharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm SuiteSharing Data with Other CAMEOfm Suite
UsersUsersUsersUsersUsers

IMPORTING/EXPORTING CAMEOFM DATA

Exporting All CAMEOfm Data
1. Activate CAMEOfm

2. Select "File" menu

3. Select “Import/Export”, and then select “Export”

4. Select “Export All CAMEO Data”

This exports all CAMEOfm records and associated MARPLOT and Site
Plan Links. It does not export the actual Site Plan image files.

Exporting Selected CAMEOfm Data
1. Activate the CAMEOfm module from which data will be exported

2. Conduct a search to select the record to include in the export

3. Select "File" menu

4. Select “Import/Export”, and then select “Export”

IMPORTING/EXPORTING CAMEOFM SITE PLANS

CAMEOfm Site Plans are image files located in the Site Plans folder. To
share them with another user, the actual image files must be
transferred.

1. Right-click on the “Start” button from the bottom taskbar

2. Select “Explore”

3. Find and open the CAMEOfm Site Plans folder

4. Select the image files to be transferred

5. “Copy-and-paste” to a folder or external storage device

6. Paste into the CAMEOfm Site Plans folder on the target
computer
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IMPORTING/EXPORTING MARPLOT DATA

MARPLOT data may be exported in threedifferent formats:

M MARPLOT Import/Export (.mie) files

M Simple Point Export (.txt) files

M ArcInfo GENERATE files*

You may use either .mie or .txt files to export “single point” objects. Use
GENERATE files to transfer MARPLOT object information to ArcInfo
systems.

IMPORTING/EXPORTING LINKED CAMEOFM AND MARPLOT
DATA

If your data contains “linked” CAMEOfm records and MARPLOT objects,
you will need to perform two exports and two imports to transfer the
data, plus copy the associated Site Plan image files as a separate
operation.

One method of exporting a “linked” CAMEOfm – MARPLOT dataset is:

1. Activate CAMEOfm

2. Activate the module containing the records to be transferred

3. Select the records to be transferred using a search

4. Export the “Found Set” to a CAMEOfm .zip file

5. Return to the “Found Set” list in CAMEOfm

6. Select the “Sharing” menu

7. Select “MARPLOT/Show all on Map”; the linked MARPLOT objects
should display as “selected”.

8. Select the "File" menu

9. Select “Export”

10. Export the “selected objects” to a .mie file

The two export files can now be imported to a different set of CAMEOfm
and MARPLOT software. After importing the CAMEOfm record to
MARPLOT, objects links should be preserved.

Note: Generally, it is recommended to use .mie files for MARPLOT to MARPLOT
data transfers.
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Data Backups/Data RecoveryData Backups/Data RecoveryData Backups/Data RecoveryData Backups/Data RecoveryData Backups/Data Recovery

CAMEOFM DATA BACKUP AND RECOVERY

To backup all CAMEOfm data, simply export all data:

1. Activate CAMEOfm

2. Select the "File" menu

3. Select “Import/Export”

4. Select “Export”

5. Select “Export All CAMEO data”

The resulting .zip file is your data backup.

DATA RECOVERY

Sometimes you will see a message in CAMEOfm indicating the “file is
damaged and must be recovered”.

One suggested method is to use the full version of FileMaker Pro. An
alternative is to use the runtime version of FileMaker that is operating
CAMEOfm.

Using FileMaker Pro 5.0 Recover Function
1. Open FileMaker Pro

2. Select “Cancel” from the opening screen

3. Select the "File" menu

4. Select “Recover”

5. Set recover browse box to “All Files”
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Example FileMaker Pro 5.0 Recover Screen

6. Locate the “damaged” file

Example of “Damaged” File in Contacts.CAM

7. Highlight and open the damaged file
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Example Contacts Recovered.CAM Screen

8. FileMaker Pro automatically creates a “name” that includes the
word “recovered”

9. Select “Save”

10. Select “OK”

This process should add a new “______ recovered.CAM” file to your
CAMEOfm folder.

If you recovered the file while CAMEOfm was “open”, you should now be
returned to active CAMEOfm screen. If you are not returned immediately
to CAMEOfm, use your Start menu to Activate CAMEOfm.

11. If the “cannot find _____.CAM” message appears, use the
resulting browse box to select the newly created “______
recovered.CAM” file.

12. Immediately export all CAMEOfm data!

This version of CAMEOfm has been compromised. It is strongly
recommended that you discontinue use of it immediately. Install a
new version of CAMEOfm and import the saved data.
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1. Install a “new” copy of CAMEOfm

2. Delete the Prince William County records

3. Import the saved data .zip file to the new CAMEOfm.

4. Uninstall the old CAMEOfm program, if necessary (The “old”
version may have been “overwritten” during installation of “new”
version).*

Using the FileMaker Pro Developer Edition
Data may be recovered without purchasing the full FileMaker Pro
version 5.0, using CAMEOfm only.

5. Close CAMEOfm, and restart while holding the Control (CTRL)
and Shift keys. CAMEOfm will open in “recover” mode.

Instructions on recovering your data using this method are found at:
http://www.filemaker.com/ti/104177.html

Note:  Be careful! Make sure you have
saved all your CAMEOfm data BEFORE
installing a new version. Consider
making at least two .zip backup files
prior to performing the installation.
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Adding LandView 5 Data to YAdding LandView 5 Data to YAdding LandView 5 Data to YAdding LandView 5 Data to YAdding LandView 5 Data to Your Hardour Hardour Hardour Hardour Hard
DriveDriveDriveDriveDrive
 Please read the entire process before you begin.

1. Install LandView 5 - it will install into your C: drive - you can
move it to another drive, after you install it, if you want to. (This
entire process will use approx. 220 mb of space)

2. Open the Maps subdirectory on the CD. Open the newly created
LV5 subdirectory on your hard drive. You want them both open -
resize the windows so they are next to each other.

3. Copy the Census, EPA and USGS GNIS and LV5 subdirectories
from the CD into the LandView 5 subdirectory. (Yes, you will
have a LV5 subdirectory inside the LV5 subdirectory).

4. Back on the CD - open the maps subdirectory then open the
tiger subdirectory then open the OK subdirectory. Select all of
the counties you want - Ctrl A will select all of them). Please
make sure that all of the counties are moved to the same level
that the MARPLOT application is at. This is very important. If
you do not do this MARPLOT will not "see" the maps.*

Note: Depending on the version of Windows you are
using - Windows 95 vs. Windows 98 vs. Windows XP -
you should check to see if the items inside these
subdirectories are locked, once you moved them into
your new LandView 5 subdirectory. To check to see if
they are locked - select all of them (Ctrl A) and then
right lick on them - check the properties - if they are
locked - please uncheck the locked box so they are
unlocked.
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5. There are three small files left on the CD that we have not
moved - please copy the Marplot.glx, Marplot.lnx and
Marplot.vnx file into the newly created LV5 subdirectory on your
hard drive. (Make sure you unlock them after you move them .)

6. Locate the Marplot.vnx file in your LV5 subdirectory on your
hard drive and open it with Notepad or another editing
program. The first line of code is:

7.  LV5 -  You need to change that to match the drive on your
computer (C:/LV5). This is only an example - if you hard drive is
labeled Fred it needs to be Fred:/LV5. Before you launch the
LandView 5 application - reboot your computer.*

Note: This process was provided by Tim Wixom of
Steuben County,  New York Emergency Management
Office.
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Importing Lat/Long Spreadsheets to LandView
It is possible to import spreadsheet data directly to LandView. This is
particularly useful when the data includes a Lat/Long value, because the
associated data is automatically “mapped and linked”.

To access the LandView “import” engine:

1. Activate LandView

2. Select the “System” menu

3. Select “User Files”

Example LandView User Files Screen

Instructions on how to import to the user files are found by selecting
the “Help” button.
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Displaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcViewDisplaying ALOHA Footprints in ArcView*****

ARCMAP ALOHA IMPORT TOOL

You can add aloha_8.dll to your ArcMap 8.x or 9.x toolbar to enable the
import of ALOHA footprint files. This version was released on July 23,
2004.

Downloading the Import Tool
If your browser supports FTP downloading (most current browsers do),
download aloha8dll.zip (i.e., the compressed version of aloha_8.dll) by
clicking the link below. Otherwise, you can use an FTP utility.

1. Download aloha8dll.zip (48K); the file is in zipped (compressed)
format, so that it can be downloaded from the internet. It is a
self-extracting zip file, so look for the file "aloha_8.dll". (Your
computer may display a message that it is unable to open the
file because it does not know what application created it. You
can disregard this message and continue with the next step.)
Download Problems? Check our troubleshooting page.

2. Save the uncompressed file in any section of your hard drive.

Installing the Import Tool
After you have saved the uncompressed file, "aloha_8.dll", in any section
of your hard drive ...

1. Launch ArcMap

2. Right-click on the ArcMap toolbar and scroll down to
Customize… (or choose the Customize… option under the Tools
menu)

3. Select the “Commands” tab on the Customize window.

4. Click the Add from file… button. Navigate to the aloha_8.dll file
on your hard drive. (If you don't see the file, your browser may
not have automatically unzipped the compressed version. Try
using Stuffit Expander.) Select the file and click Open to add the
Aloha Import Tool to your available tools. Click OK.

Note: The following is reprinted from NOAA webpage: http://
response.restoration.noaa.gov/cameo/dll8.html

○
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5. In the scrollable list on the left side of the Customize… window,
highlight ArcObjectTools. To the right you should see the Aloha
Footprint Extension command.

6. Click and drag the hula girl icon onto your standard toolbar.
Release the mouse button when your cursor becomes a vertical
bar. (You need to release the mouse button at or before the last
icon on your toolbar.)

7. Exit the Customize… window. You are now ready to use the
Aloha Footprint Extension!

8. To remove the Aloha icon from your toolbar, open the
Customize… window and drag the icon off the toolbar.

Using the Import Tool
When the footprint option is chosen from ALOHA, a file entitled
alo_ftp.pas is created and placed in the ALOHA directory. This file will
be deleted when ALOHA is shut down, so it is best to rename the file in
case you want to import the footprint into ArcMap after ALOHA is off. Be
sure, however, to retain the .pas suffix so ArcMap will recognize the file
as an ALOHA footprint.

To use the ArcMap Tool, simply click on the hula girl icon. You will be
guided through the import process. You will need to provide the source
site of the release, either in decimal degrees or degrees, minutes, and
seconds. The geodatabase that is created will have a defined coordinate
system (geographic coordinates, WGS-84). This allows ArcMap to
reproject the footprint layers if you have other data layers in a different,
defined coordinate system.

You will also need to navigate to the ALOHA footprint .pas file and can
specify an alternate name for the geodatabase (the default will be the
name of the chemical released).

The mapped output will include a layer for each level of concern
specified in the ALOHA .pas file. The layers will be named with these
levels of concern. In addition, a balloon callout box containing the
parameters of the spill and other relevant information is displayed. This
box and the red dot showing the release site are graphic elements and
may be moved or deleted using the graphic selection too.

With the aid of this tool, you will be able to view and query the ALOHA
footprint output with other data layers available for your ArcMap
session.
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Accessing TAccessing TAccessing TAccessing TAccessing TerraServer Aerial Photos anderraServer Aerial Photos anderraServer Aerial Photos anderraServer Aerial Photos anderraServer Aerial Photos and
TTTTTopographic Maps via LandViewopographic Maps via LandViewopographic Maps via LandViewopographic Maps via LandViewopographic Maps via LandView
LandView features a direct connection between the USGS Geographic
Names Information System records (GNIS) and the USGS TerraServer web
pages found on the internet.

The connection is accessed via the LandView USGS “Web Link” button,
only if the computer in use is connected to the internet.

1. Activate LandView

2. Open the USGS GNIS database

3. Select the “View as List” button

Example LandView GNIS list screen

All of the thousands of GNIS records are directly connected to the
TerraServer webpage.

4. Select any GNIS record

5. Select the “Web Link” button
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Example TerraServer Screen Following a LandView Web Link Request

Aerial photos are found by selecting the “Digital Orthophoto
Quadrangle (DOQ)” link.
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Example TerraServer Aerial Photo

Topographic maps are accessed by TopoZone.com or the digital raster
files.
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Example TopoZone.com Map

Example Raster Map
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INSERTING TERRASERVER AERIAL PHOTOS AND TOPOGRAPHIC MAPS

INTO MARPLOT

Saving the TerraServer Image to your Computer

1. Activate the TerraServer webpage

2. Select the image you wish to display in MARPLOT

3. Right-click on the image

4. Select “Save Picture As”

5. Make sure to save the TerraServer image as a “bitmap” or
“.bmp” file

MARPLOT only displays .bmp files. It will NOT display .jpg or .gif files.

MARPLOT Simple Insert

1. Activate MARPLOT

2. Set map display an area slightly larger than image file to be
inserted

3. Create or open layer

4. Select "Edit" menu

5. Select “Insert Picture Object”

6. Select “Use Existing Map” and “File”

7. “Browse and Open” the saved TerraServer image file
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Example Inserted Picture Object Settings box

At this point, the image may be displayed in MARPLOT by selecting “OK”
or you may select the Geo-Reference option to more accurately locate
the image on the map.
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MARPLOT Geo-Reference
Geo-Reference function allows you to specify two Lat/Long points on the
image file. MARPLOT then positions the image on its map based on
those Lat/Long values.

Example MARPLOT Geo-Reference Picture screen

For instructions on Geo-Referencing, select the “Help” from the Geo-
Reference Picture screen.
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SAVING AERIAL PHOTOS TO CAMEOFM SITE PLANS

TerraServer picture files may be saved to CAMEOfm Site Plans folder and
linked to Facilities and/or Special Locations records. Saving the image
files to Site Plans offers some significant benefits:

1. The image may be viewed without need of internet access

2. CAMEOfm Site Plans will accept smaller image file formats (i.e.,
jpg, .gif, .tif.)

3. The TerraServer image files may be altered and edited to
display additional information; such as worst-case ALOHA
footprints, initial isolation areas, entrance and egress areas,
population counts of surrounding neighborhoods...the list of
information you may wish to add to the aerial photo is endless!

Saving an aerial view of a facility to CAMEOfm Site Plans, and
adding your own preplanning data to that photo, can be an
extremely useful tool for HazMat responders and planners!
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.bmp  29, 30, 55, 56, 74
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.mer  16, 40, 42, 46, 47, 51, 53, 54

.mie  16, 36, 60
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ArcView  11, 36, 37, 68

BBBBB

Basic Search  39
Bitmap  54, 74
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CAMEO website  3
Census  11, 65
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Color  11, 32
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Data Backup  61
Data Recovery  61
Dose  57
Draw Tool  31, 56

EEEEE
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General Description  10
GENERATE  16, 60
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Insert Picture  30, 31, 74, 75
Iinternet  11, 68, 70, 77
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Lat/Long  28, 37, 67, 76
Layer List  31
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Mail Merge  54
Mailing List  54
Make Report  53
Map Data  39
MapData.CAM  44, 45, 46
MapInfo  11
Microsoft  9, 11, 13, 15, 16, 17
Microsoft Excel

9, 13, 15, 18, 19, 20, 21, 28, 32, 33, 37, 40, 41, 42, 43, 46, 47, 51, 53, 54
Microsoft Word  13, 53, 54, 57
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Navigator  46, 50
Notes  23
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Object Settings  29, 31, 43, 75
Open layer  30, 74
Orthophoto  71
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Planning Mode  57
“Polygon” tool  56
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Properties  37, 65
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Relational Database  9, 11
Response Mode  57
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RMP-COMP  9
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